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TechnoDebate Overview 
  

Purpose: Create an animated debate that 

presents a persuasive argument justifying a 

position on a controversial issue. 

Preparation: (see Preparing to Teach) 

 Sign up for a Google Account 

 Install Adobe Reader or other PDF app 

 Share Debate folder with students 

 Prepare TechnoDebate folder  

(optional steps for Assignment 1) 

 

Objectives: (see Appendix A Skill Summary) 

 understand the purpose of a debate 

 examine different perspectives 

 select a position on a controversial issue 

 research to develop a logical argument 

 concisely and clearly express a viewpoint 

 support argument with relevant evidence 

 evaluate ideas to rebut an argument 

 make an intellectual or emotional appeal 

 use persuasive language to sway opinions 

 respect others' ideas 

 work collaboratively to produce a debate 

 share a file and set permissions 

 insert and format slide objects 

 animate slide objects 

 adjust slide order to sequence a debate 

 post, read, and reply to comments 

Materials: (see Appendix B for a complete list) 

 Debate Checklist 

 Individual Debate Marking Sheet 

 Debate Rubric 

 Debate Skill Summary 

 Debate Judging Sheet 

 Debate folder 

o Workbook Assignment Sheets 

o Sample Debate – bike lanes 

o Argument Planner template (optional) 

 Parent Letter and Certificate (optional) 

  

 

Summary of Activities: 

 Gain an understanding of the purpose of a debate. View sample debate and answer questions. 

 Partner up. Brainstorm to select a controversial issue for the debate, then pick a position. 

 Investigate topic to develop argument. Research to find evidence to support three main points. 

 Invite partner to share a Google slides file. Make the title slide together. 

 Create a new slide that states position using a clip art character and callout bubble. 

 Make a series of slides that present a persuasive argument. 

 Prepare a rebuttal. Identify opponent's weakest point and refute claim in a counter-argument. 

 Summarize ideas to convince audience to agree with a particular viewpoint. 

 Animate callout bubbles to produce an animated conversation. Apply transitions to divide debate. 

 Complete a debate checklist. 

 Invite audience members to view debate and pose questions using Comments. 

 Reply to audience questions to defend position. 

 

Extension Activities: 

 Debate Topics: Activities to select a controversial issue to debate. 

 Research using Google Docs: Using the Research tool to search for information and cite the source. 

 Insert a Character Workshop: Discover multiple methods to insert images onto slides. 

 Cross-Examine your Opponent: Have each side ask their opponent a question. 

 Judge Debate: Declare a "winner" of the debate. Who made a more convincing argument? 
 

 

Assessment: 

 Self-Evaluation (Debate Checklist – Assignment 10) 

 Teacher Evaluation (Individual Debate Marking Sheet, Debate Rubric, Debate Skill Summary) 

 

 

Notes: 

 If you are a classroom teacher have students create a debate on a controversial issue that is 

subject-related. 

 If you are a computer teacher have students build a debate on a school-related topic, pop 

culture, or area of interest. 
 



TECHNOKIDS INC. iii TECHNODEBATE 

Technology Integration Ideas 

TechnoDebate integrates into curriculum. This project can be used to develop critical thinking, 

persuasive writing techniques, collaboration skills, and an appreciation of multiple viewpoints. 

Students can debate on a wide range of topics. You may wish to include project activities as 

part of a social studies, language arts, history, or science unit. Below are some suggestions: 

 

 Citizenship Debate:  Care about where you live. What does your community require? 

How can you help people in need? What action will improve the quality of life for others? 

 Democracy Debate: Become a stakeholder and state your perspective. Should a law 

pass? Is a rule fair? Should development proceed? Who should pay for an initiative? 

 Ethical Debate: Analyze a moral dilemma to understand diversity in values and beliefs. Is 

an action right or wrong? Are you for or against an issue? Are the motives of people 

good or bad? Is a decision justified or unwarranted? Is it helpful or harmful?  

 Advocacy Debate: Highlight a problem with the status quo. Why is there a need for 

change? What makes the current situation unacceptable? 

 Proposal Debate: Determine which course of action is the best. Why is Plan A better than 

Plan B? What are the advantages to a new plan? Why is the current system ineffective? 

 Literature Debate: Discuss events that happened in a story. Was the decision made by a 

character right? Did the character deserve to win? Were the actions of a character fair? 

What choice should a character make? Should a character have done that action? 

 Historical Debate: Think like a historian. Investigate a time in history to gain a better 

understanding of the people and events. What evidence suggests current understanding 

of a historical event is wrong? Was a historical decision fair to all stakeholders? What 

would a significant person say in a debate about an issue during their time? 

 Environmental Stewardship Debate: Discover the balance between human needs and 

the sustainability of the environment. Is economic growth or nature more important? How 

should humans adjust their behavior to protect the environment? Who should have 

access to natural resources? What needs to change to protect the environment for 

future generations? 

 

 

 

Tips for Topic Selection: 

 

 Review Topics: Once your students have selected a topic make sure it is appropriate for 

a school environment and will not insult an individual student. 

 Novel Debate Ideas: The Internet has many online debate websites that have the 

pro/con arguments posted. To encourage critical thinking have students debate an 

original topic such as a local issue, current event, or school policy. This will prevent copy 

other people's ideas. 
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Prepare to Teach TechnoDebate 

 

Complete the following: 

 

Step 1: Install Google Chrome 
Step 2: Create a Google Drive Account 
Step 3: Install PDF App 
Step 4: Share Workbook Files with Students 
Step 5: Pick a Method to View Bike Lane Sample and Prepare Materials 
Step 6: Select Assessment Tools (Optional) 
Step 7: Print Handouts (Optional) 

 

Step 1: Install Google Chrome 

 

It is recommended that you use Google Chrome as your browser when completing this project. 

Other browsers may work with Google Slides but may limit features. Chrome is free and can be 

downloaded http://www.google.com/chrome/. Make sure cookies and JavaScript are turned 

on for the browser. 

 

For a complete list of system requirements visit the Google Support page 

https://support.google.com/drive/answer/2375082?hl=en&ref_topic=14940. 

 

Step 2: Create a Google Drive Account 
 

Your students must have a Google Drive Account. Your school may have granted each student 

an account. If your students DO NOT have an account they will need to register for free. An 

existing email address may be used to create a Google Drive account. 

 

To create a new account, students must visit https://docs.google.com. 

 

Step 3: Install PDF App 
 

The teacher guide and student workbook files are in PDF format. Each assignment in the 

workbook is available as an individual file. Students can type answers into the worksheets. There 

are several free PDF reader options: 

 Adobe Reader (visit www.adobe.com) 

 Notable PDF - Chrome App 

 

Step 4: Share Workbook Files with Students 
 

The Debate folder contains a template, sample, and worksheets. Each assignment in the 

workbook is available as an individual file. The Debate folder can be placed on a local 

computer, memory stick, school server, or private web-based folder (not available to the public). 

1. Open the TechnoDebate Resources folder. 

2. Copy the Debate folder. Paste it in a desired share location, 

or upload the folder contents to a private web-based location. 

 

  

http://www.google.com/chrome/
https://support.google.com/drive/answer/2375082?hl=en&ref_topic=14940
http://www.adobe.com/
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Assignment 1  What is a Debate? 
 

In this project, you are going to design an animated debate that presents convincing arguments 

for both sides of an issue.  

What is a Debate? 

 

A debate is a structured argument between two sides about a 

controversial issue. It is an exchange of ideas. One side is for an issue and 

the other side is against the issue. The purpose of the discussion is to 

convince an audience to agree with a particular point of view. 
 

Typically, a debate is done face-to-face, in front of an audience. Each side is allocated a set 

amount of time to present their argument, ask or answer questions, highlight weaknesses in their 

opponent's position, and summarize their ideas. 
 

What is the Purpose of a Debate? 

 

Debates are part of a democratic society. They allow people an equal opportunity to state their 

opinion and ask questions about the ideas presented. A debate can be used to: 

 emphasize the importance of an issue 

 inform the public about a topic 

 understand differing viewpoints 

 engage people in the decision-making process 

 defend or challenge a system, plan, policy, or action 

 change the opinion of an audience 

 showcase the abilities of the debater 

 

What Skills make you a Good Debater? 

 

A debater is opinionated, articulate, logical, respectful, quick-thinking, and persuasive. 

What type of debater are you? For each question, answer what you do during most discussions. 
 

Do you  pick a side or  find it difficult to take a stand?  

Do you  express your ideas clearly or  struggle to find the words? 

Do you  offer examples about why you are correct or  keep insisting you are right? 

Do you  listen to understand others ideas or  ignore ideas that differ from your own? 

When questioned do you  reply with a response quickly or  take time to think? 

Do you  easily get others to change their mind or  rarely persuade others?  
 

 

Add the checkmarks from the first box of each statement. What type of debater are you? 

- 4-6 Expert Debater - You know how to communicate your ideas effectively. 

- 2-3 Great Debater - You can usually persuade others. A few tricks will turn you into an expert. 

- 0-1 Rookie Debater – Great news! The activities in this project will turn you into an expert. 
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What Format will be used for the Debate? 

 

In TechnoDebate, the exchange of ideas occurs digitally. The debate will use a format similar to 

a public debate: 
 

 Take a stand:  Each side will state their position on the topic. This statement is called a 

resolution.  

 Present a persuasive argument:  Each side will build their case by presenting three 

arguments using evidence such as statistics, expert opinion, or observations to support 

their ideas. This is called a constructive speech. 

 Prepare a rebuttal: Each side will examine the arguments made by the opposition to find 

weaknesses. They will explain why the ideas presented by their opponent are flawed. This 

is called a rebuttal. 

 Summarize ideas: Each side will summarize their main points and emphasis why their 

position is correct. The summary should make an appeal to the audience. 

 Invite audience participation: The presentation will be shared with audience members. 

The audience will ask questions to which the debaters will respond to defend their 

position. This is called a cross-examination or crossfire.  

 Judge debate (optional): The teacher, panel of peers, or audience members will 

determine which side presented the strongest arguments and were the most persuasive. 

 

Study a Sample Debate 

 Ask your teacher how to view the bike lanes debate.  

Click to read the callout bubbles in the debate. 

1. The affirmative or PRO side of a debate is "for" the topic.  

 

 What character is used for the pro side? 

 boys and girls riding bikes 

  

2. The negative or CON side of a debate is "against" the topic. 

 What character is used for the con side? 

 boys and girls driving cars 

 

3. What three arguments does the PRO side make for having bike lanes on city streets?  

 reduce air pollution  decrease traffic congestion  increase cyclist safety  

 

4. What three arguments does the CON side make for not having bike lanes on city streets? 

 too expensive  restrict traffic flow  help only a few people  

 

5. Each side of the debate rebuts or explains why their opponent is wrong. Which side did a 

better job highlighting flaws in their opponent's argument? Why do you think so? 

   

 

6. The purpose of a debate is to convince an audience to agree with a viewpoint.  

Do you think the PRO or CON side had a more persuasive argument? Why?  

   
 

 
 

If you want to see another sample, view the school food debate. 
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Assignment 2  Brainstorm a Topic for your Debate 
 

Debates are a great way to discuss an important topic.  

You will work in partner groups. Team up to pick a question  

or come up with your own idea.  

Debate Ideas 

 

School Debates Environmental Debates 

 Is the dress code fair or should it change?  Is coal really a clean energy source? 

 Is homework good for students?  Should fracking be permitted? 

 Is it right to lose marks for late work?  Are fishing restrictions fair? 

 Should ___ be taught in school?  Should plastic water bottles be banned? 

 Is year round schooling better?  Are jobs or the environment more important? 

  

Community Debates Science Debates 

 Should bike lanes be added to streets?  Is stress helpful or harmful? 

 Is expanding the airport a good idea?  Do video games cause real violence? 

 Should a new ___ be built in the area?  Is space exploration a waste of money? 

  Are genetically modified foods safe? 

Current Events Debates  Is fluoride in water a good idea? 

 Was the treatment of ___ fair?  Is the large hadron collider necessary? 

 What plan is better, ___ or ___?  

 Policy Debates 

Ethical Debates  Should the age to drive be lowered? 

 Should parents lie about the tooth fairy?  Should voting be mandatory? 

 Should zoos be allowed to operate?  Should teenagers be included in a jury? 

 Is it wrong to eat meat?  Do gun control laws make people safe? 

 Is cloning extinct animals a good idea?  Should immunization be compulsory? 

 Should athletes use performance drugs?  

 Should women over 50 have babies? Literary Debates 

 Should animal testing be banned?  Did the character make a good decision? 

  

General Opinion Debates History Debates 

 Are cats better than dogs as pets?  Was ___ a good leader? 

 Do cell phones improve communication?  Was the decision to ___ right? 

 Is the original movie or the remake better?  

 

Select the Topic for your Debate 

 

1. What is the topic of your debate?  

2. What side of the issue are you debating?  

Need more ideas? 

Complete 

Extension Activity 1. 
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Assignment 3  Plan Arguments 
 

In a debate, each side is given an equal opportunity to explain their viewpoint. You need to 

research three main points and provide the best evidence to support each argument. The 

evidence can be statistics, expert opinion, or observations. 

 Open Argument Planner in the Debate folder using Google Docs 

or print this page or complete the PDF worksheet.  

 

Debate Topic  

Side/Position  

 

Main Point/Argument Evidence to support argument 

  

  

  

 

 
 

Need help? Extension Activity 2 offers research strategies. 
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Assignment 4  Invite a Partner to Debate 
 

You and your partner will work together to create an animated 

debate. To do this you need to be working on the SAME file at the 

SAME time. Follow the instructions to share a Google Slides file. 

The person on the PRO or "for" side of the debate will create and 

share the file with the CON or "against" side. 

Login to Google Drive 
 

Create a Presentation and Rename the File (PRO side) 

 Click New. Select Google Slides. 

 Select a theme, then click OK. 

 
 

 In the top LEFT corner replace Untitled Presentation with Debate Topic. Click OK. 

 

Introduce the Debate Topic on the Title Slide (PRO side) 

 In the Click to add title box type Debate Topic or Debate Question. 

 Format the font, size, style, color, and alignment of the title. 

 Set the typeface by choosing an option from the Font menu. 

 Set letter size. Pick an option from the Font Size menu or type a value into the box. 

 Click Bold to make letters appear darker. 

 Click Italic to make letters slant to the right. 

 Choose a text color from the palette to change the color of letters. 

 Align text to the left, center, or right of the text box margin. 

 In the Click to add subtitle box type PRO: Your Name. 

 
 

If the Choose a theme pane 

does not appear, select from 

the Slide menu, Change theme. 

Your partner will add 

their name once you 

share the file. 
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Share the File with Partner (PRO side) 

 From the File menu, click Share. 

 Type in your partner's email address. (It is best if it is a web-based account) 

 Click the permission arrow and set it to Can edit. 

 

 Click Send. 

 

 

Open the Shared File (CON side) 

 Click Shared with me in Google Drive. Open the debate file. 

or view your email, and click on the hyperlink in the message. 

 

 

Add Student Name to the Title Slide (CON side) 

 Below your partner's name, type CON: Your Name. 

 
 

 

 
 

Log Out of Google Drive 

 

About sharing: Do not overwrite your partner's work. 

Before adding text or a picture, look for a cursor to 

show where your partner is working.  

This will allow you and 

your partner to work 

together on the SAME 

file at the SAME time. 

Your partner can see 

where you are typing. 

A cursor will display 

on the screen. 
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Assignment 5  Take a Stand 
 

In this assignment, you and your parter will each make a slide that includes a statement briefly 

outlining a side of the debate. This is called a resolution.  
 

You and your partner will: 
 

 insert a new blank slide and format the background 

 insert a debate character 

 add a callout bubble and format the appearance 

 make a statement that briefly describes position 

 

Login to Google Drive and Open the Debate 

 

Insert a New Slide and Select a Blank Layout  

 Click the New slide arrow. Choose Blank. 

 
 

Format the Background Color 

 Click Background. 

Or from the Slide menu, click Change background. 

 Click the arrow beside Color and pick a color. Click Done. 

 

 View the slide thumbnails: 

 
  

Pick a different color than 

your partner, so your slide 

will be easy to identify. 

You can easily identify your slide 

from your partner's because they 

are different colors. Rest the 

mouse pointer over your 

partner's slide. A symbol appears 

to identify the slide your partner 

is working on. 

The slide your partner is 

working on has a symbol. 
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Assignment 6  Present a Persuasive Argument 
 

You and your partner will make three slides that present 

arguments using evidence to suppport a position. The 

argument is called the constructive speech. Your goal is to 

convince an audience your side of the debate is correct.  
 

You and your partner will: 
 

 duplicate a slide 

 flip character on slide 

 edit text in callout to present arguments 

 position slides in the debate 

 

Login to Google Drive and Open the Debate 

 

Duplicate a Slide 

 Select the thumbnail of the slide you created in the previous assignment. 

From the Slide menu, select Duplicate Slide. 

 

Flip a Character 

 Make sure you are working on the duplicated slide. 

 Select the character. 

 From the Arrange menu, select Rotate. 

Click Flip Horizontally. 

  

You can replace the character but keep the scale and position of the 

original image. Try it!  

 

Select the image. From the Format menu, select Replace image. Use 

your skills to find a suitable image. Click Select.  

This is a great way to pretend you have more than one 

person on your debate team. When replacing images find 

new images that are a similar style. 

Duplicating a slide is a fast way to 

make new slides. You can edit the 

text in the callout to make your 

character say something new. 
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Assignment 7  Prepare a Rebuttal 
 

Your partner has made a strong argument. Is their side right?  
 

No! 
 

You need to convince the audience your opponent is wrong by 

finding a weakness in their argument. This is called a rebuttal. In a 

rebuttal you make a counter-argument that refutes an 

opponent's claims. You and your partner both need to prepare a 

rebuttal. 

 

Login to Google Drive and Open the Debate 

 

Find a Weakness in your Opponents Argument 

 Read each argument made by your opponent.  

You need to find a weakness in their argument. 

o Are there other facts that disprove their argument?  

o Have they exaggerated or over-simplified the issue? 

o Can you find survey or poll results to show they are wrong? 

o Could there be other causes or reasons that have been over-looked? 

o Is their plan weak in a particular area? 

o Did they ignore an important point? 

o Is one of their arguments illogical? 

 

Use Research Tool to Locate Facts to Disprove Opponent's Argument (Optional) 

 From the Tools menu, pick Research. 

 Type search term into Research box. Click the drop down box and select Everything. 

 When you find a site you might like, hold the cursor over it. 

Click Preview to see a preview pane of the site. 

 

 Click on the page to open it in a new browser tab. 

Or close the pane to make another choice. 

Can you find a fact that 

proves that your 

opponent is wrong? 
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Assignment 8  Summarize Ideas 
 

This is your last chance to persuade the audience that your 

viewpoint is correct. How can you make people care about this 

issue and take your side? 

 

You and your partner need to each write a summary that acts 

as a closing argument in the debate. In the summary, justify your 

position by reviewing the arguments. Connect with the 

audience by appealing to their intellect or emotions.  

 

Login to Google Drive and Open the Debate 

 

Convince the Audience you are Right 

 Select one of your slides and duplicate it.  

 Move it to the END of the debate. Tip: The PRO summary goes before the CON summary. 

 Replace the text in the callout with your summary. 

 
 

Tips and Suggestions: 

o Stress the importance of the issue 

o Make points your audience will care about or can relate to 

o Repeat your strongest argument 

o Remind the audience about the flaw or problem in your opponent's case 

o Appeal to the intellect or emotion of the audience 

o Do not introduce new information 

 

 

Sentence starters: 

In summary… It is important to understand… 

In conclusion… It is difficult to ignore… 

It is vital that… I am sure you will agree… 

At the forefront of this debate is… For all these reasons, it is essential... 

The opposition has tried to convince you… It is logical to conclude… 

Everyone should be concerned about… It is clear… 

The evidence presented shows… Say "yes" (or no) to… 
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Assignment 9  Design an Animated Conversation 
 

You can add simple animation. This will allow you to create an 

animated exchange of ideas. When people watch your debate, each 

time they click on a slide a callout bubble will appear. When they click 

again the next slide in the debate will display.  

 

You partner will animate the slides THEY created and you will animate 

the slide YOU created. If you have time, you may want to add 

transitions to divide your debate into chunks. 
 

Login to Google Drive and Open the Debate 

 

Animate Callout Bubbles 

 Select a callout bubble. 

 From the Insert menu, select Animation. 

 Click the Animation box arrow.  

Select a type from the drop down menu. 

 

 Click Play. Click to see the animated callout bubble. 

Click again to end the preview. 

 Use your skills to animate the remaining callout bubbles on each of your slides. 

 

View the Debate 

 When you and your partner are finished animating, click the Present arrow. 

Select Present from beginning. 

 Click to read each callout bubble and advance each slide. 

 When you reach the end, press ESC. 

  

Select the On click option 

Set the speed 

Pick a simple animation 

such as Appear or Fade in. 
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Assignment 10  Debate Checklist 
 

Work with your partner.  

Use the checklist to make sure that the debate is complete. 

 

Is your Debate Complete? 

 

Debate Structure and Content  

The title introduces the topic of the debate. 
 

The position of each debater is outlined on the title slide.  

The statement or resolution outlines position and main points in the argument.  

There are three arguments for each position in the constructive speech.  

Each argument is expressed clearly and offers evidence to support the claim.  

Each argument is convincing.  

Ideas are well-organized with the strongest points presented first.  

The rebuttal identifies a weakness in the opponent's argument.  

The rebuttal provides relevant evidence that disproves the opponent's argument.  

The summary justifies the position by reviewing arguments.  

The summary addresses audience concerns by making an intellectual or emotional plea.  

Slides are in the correct order.  

Spelling on all slides is correct.  

Design  

A suitable theme has been applied to the debate.  

The background color for the PRO and CON sides is different.  

The debate character is a good fit for the topic or viewpoint.  

The text in each callout is easy to read.  

Each callout has animation to make it look like the character is talking.  

Word art, additional images, and/or slide layout enhance the message (optional).  

Transitions add interest, divide the debate into parts, and distinguish the sides (optional).  
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Assignment 11  Invite Audience Participation 
 

In a public debate often the audience or a moderator asks questions. This 

part of the debate is called a cross-examination or crossfire. Questions 

allow the audience to clarify misunderstandings, seek additional 

information, or raise an important issue that was ignored during the 

debate. Each debater is able to defend their position with the goal of 

convincing the audience that their side is right. 

 

Have the CON side share the debate with a small group of audience members. Each member 

will be able to use Comments to post their questions. In the next assignment, you and your 

partner will reply to the questions to defend position. 

 

Login to Google Drive and Open the Debate 

 

Share the File with Audience Members (CON side)  

 From the File menu, click Share. 

 Type in your audience members' email addresses. (It is best if it is a web-based account.) 

 Click the permission arrow and set it to Can comment. 

 

 Click Send. 

 

Open the Shared File (AUDIENCE members) 

 Click Shared with me in Google Drive. Open the debate file. 

or view your email, and click on the hyperlink in the message. 

 Click Present. Read the animated debate.  

 When finished, press ESC. 

 

  

This will allow 

audience members 

to view the debate 

and post comments. 

They will not be able 

to edit your work. 



 

TECHNOKIDS INC. 22 TECHNODEBATE 

Assignment 12  Respond to Audience Questions 
 

The audience has asked their questions. Now you and your partner need 

to defend your postion by providing answers. Audience members will be 

able to read your reply. 

 

Login to Google Drive and Open the Debate 

 

Read Comments and Reply to Answer Questions 

 Click Comments. 

All questions will be posted in a pane. 

 

 Click Reply. 

Type answer.  

 Click Reply to post response. 

 
Tips and Suggestions: 

o Be brief. 

o Stay on point. 

o Do not provide information that is not related to the question. 

 

 

Log out of Google Drive 

Sentence starters: 

It is important to realize… A recent study shows… 

Although this may be the case… An example is… 

Yes, I think this because… There is evidence to suggest… 

If the audience 

member opens the 

debate and clicks 

Comments they will 

see your answer. 
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Extension Activity 1: Debate Topics 

Are you having difficulty picking a topic to debate?  

Complete this activity to get your creativity flowing!  

Make a list of possible debate topics. Which idea do you like the most? 

 

1.  Rate your level of interest in a topic area. 

 

  
not 

interested 

somewhat 

interested 

very 

interested 

 school policy    

 community activities    

 environmental issues    

 animal rights    

 current events    

 government policy    

 scientific research    

 health and wellness    

 technology    

 sports    

 fashion    

 pop culture    

 

2. Still need a question to debate? Complete each sentence.  

Do you like any of these ideas? 

 

Which is better  or  ? 

 

Is  more harmful than good ? 

 

Are   a better option ? 

 

Do you agree or disagree that    should be changed ? 

 

Should   be banned ? 

 

 

3. Are you still having trouble picking a topic? Use the words below to trigger an idea. 

 

gun control social media standardized testing better or worse 

censorship internet privacy drugs or alcohol good or bad 

cosmetic surgery cloning off shore drilling start or stop 

eating habits space exploration stem cell research keep or change 

beauty pageants pet care stereotypes necessary or optional 

role models urban development climate change permit or ban 

reality TV celebrities ethics increase or decrease 

curfews free trade drones right or wrong 

Which areas did you 

select as somewhat 

interested or very 

interested? 

 

For each one list possible 

issues you could debate: 
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Extension Activity 5: Judge Debate 

A debate is about a controversial issue. Often the topic or question 

being discussed does not have a correct answer. Instead, both sides 

have valid points that can be made for or against an issue. Winning 

a debate is not about being right. Instead, winning a debate is 

based on being more persuasive than your opponent when 

presenting arguments.  
 

Which side was the most convincing? Who won the debate? 
 

Voting Instructions: 
 

1. Present or share your debate with a judge or audience of peers.  

2. Give each judge a Debate Judging Sheet. 

3. For each criteria, the judge must determine if the PRO or CON side did a better job. 

4. Each judge tallies results to select a winner. 

5. The judge needs to explain the main reason for making their decision.  
NOTE: If there is more than one judge, the side that has the majority of votes is the winner. 

 

Judging Tips: 
 

 Set aside personal beliefs. 

 Pretend you know nothing about the topic. 

 Make a decision based only on points made by each side. 

 Evaluate each side based on the quality of the arguments. 

 Do not be influenced by friendship when making a decision. 

 

Debate Topic:  

 

PRO Side:   CON Side:  

 

 PRO CON 

Which side had the most persuasive argument?   

Which side had the most convincing rebuttal?   

Which side was the most knowledgeable about the topic? 
  

Which side answered audience questions most successfully?   

Which side had slide designs that supported the message the best?   

 

Winning Side:  

 

Main reason for decision:  
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Appendix A: Assessment Tools 

 

Individual Debate Marking Sheet 
 

Name:  

Topic:  

Side/Position:  

 

 

 

The title slide introduces the topic and position of each debater. 

/1 

The statement or resolution clearly outlines the position and main points of the argument. 

/1 

The constructive speech has logical arguments supported by evidence. 

/12 

The rebuttal provides relevant evidence disproving the opponent's weakest argument(s). 

/3 

The summary justifies the position and appeals to audience concerns. 

/2 

Ideas presented are well organized, informative, and use effective word choice.  

/5 

Slides in the debate are sequenced correctly. 

/1 

Spelling on all slides is correct. 

/1 

Design elements suit the topic and enhance the message. 

/7 

Response to audience questions during cross-examination defends the position. 

/2 

TOTAL /35 
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Debate Rubric 
 

Student Names  

Topic:  

 

 POOR – 1 FAIR – 2 GOOD – 3 EXCELLENT – 4 

STATEMENT 

Position is unclear 

and/or arguments are 

missing. 

Position is stated with 

some arguments 

outlined. 

Position is stated with 

arguments outlined. 

Position is clearly 

stated with arguments 

outlined. 

CONSTRUCTIVE 

SPEECH 

Many arguments are 

illogical and lack 

evidence or have 

major inaccuracies. 

Most arguments are 

logical but a few lack 

evidence or are 

inaccurate. 

Arguments are logical 

and provide relevant, 

accurate evidence. 

Arguments are logical 

and provide a range 

of evidence that is 

relevant, accurate, 

and convincing. 

REBUTTAL 

Counter-argument is 

unrelated to 

opponent's claims. 

Counter argument 

identifies a weakness 

in opponent's 

argument, but lacks 

relevant evidence to 

refute claim. 

Counter argument 

identifies a weakness 

in opponent's 

argument and 

provides relevant 

evidence to refute 

claim. 

Counter argument 

identifies a weakness 

in opponent's 

argument and 

provides relevant 

evidence to refute 

claim using persuasive 

logic. 

SUMMARY 

Summary lacks a 

review of arguments 

and does not justify 

position to an 

audience. 

Summary provides a 

review of some 

arguments, but does 

not justify position to 

an audience. 

Summary provides a 

concise review of 

arguments that justifies 

position to an 

audience. 

Summary provides a 

concise review of 

arguments that justifies 

position to an 

audience, using 

phrasing that appeals 

to their intellect or 

emotion. 

CROSS-

EXAMINATION 

Response to audience 

questions provides 

information that does 

not adequately 

defend position. 

Response to audience 

questions provides 

information that 

somewhat defends 

position. 

Response to audience 

questions provides 

information that 

adequately defends 

position. 

Response to audience 

questions provides 

information that 

strongly defends 

position. 

ORGANIZATION 

Ideas lack 

organization and 

debate is not well 

sequenced.  

Ideas are somewhat 

organized and/or 

debate is not 

sequenced correctly. 

Ideas are organized 

and debate is 

sequenced correctly. 

Ideas are very well 

organized and 

debate is sequenced 

correctly. 

KNOWLEDGE 

Debate demonstrates 

a poor understanding 

of topic. 

Debate demonstrates 

a limited 

understanding of the 

topic. 

Debate demonstrates 

a proficient 

understanding of the 

topic. 

Debate demonstrates 

an in-depth 

understanding of 

topic. 

DESIGN 

The design does not 

enhance the 

message. 

The design somewhat 

enhances the 

message. 

The design enhances 

the message. 

The design strongly 

enhances the 

message. Design is 

original and creative. 

 


